EXCEL TUTORIAL

This tutorial contains 7 lessons that will help the non-Excel user learn to perform
most of the basic Excel functions. Each lesson contains hands on skill
development practice activities, which are found in the companion
excelbasicstutorial.xls spreadsheet. (INSTRUCTIONS FOR EXCEL 2007 ARE IN
BLUE, IN PARENTHESES, LIKE THIS NOTATION. READ THE PARAGRAPH THAT
APPLIES TO PRE-2007 EXCEL, THEN NOTE THE CHANGES IN BLUE, AND YOU
WILL UNDERSTAND HOW TO COMPLETE THE TUTORIAL IN 2007.)

Most students have found that the best way to go through the practice activities
is to print this Excel Tutorial and have it by your computer as you complete each
practice activity.

Note to future teachers: Feel free to use any part of this tutorial with your
students in the future. It was originally developed for use with grade 2-12
students in mind. Obviously, some of the text had to be changed for elementary
students. Both will be available on my Website, which can be accessed at
www.wtamu.edu/~jrutledge.

Definitions. Lesson 1

Before completing the tutorial, the user may want to review these definitions,
which are also contained in the User Guide:

1. SPREADSHEET-software designed to organize, manipulate and calculate
data. The software is configured in rows and column pattern, which creates
cells that are used to input data. In a cell, calculations can be performed on
data from other cells using mathematical operations

2. COLUMN--The vertical divisions of a spreadsheet, which are labeled with a
capitol letter to denote each row, e.g., columns A, B, C, & D. After Z, cells
begin to be denoted as AA, AB, AC, etc. and continue to the right thru cell
IV, or 230 columns. Think of columns as the poles that hold up a front
porch of a house to remember that columns go up and down (vertical).

3. ROW--The horizontal divisions of a spreadsheet, which are labeled with a
number to denote each row, e.g., rows 1, 2, 3, & 4. The first row is row 1,
and the last row is row 65, 536. The teacher probably will never do anything
in Excel to cause the user to run out of rows.

4. ROW LABELS AND COLUMN HEADERS--labels at the top of a column
and/or row that identifies the data in the cells under the column header
and/or to the right of the row header

5. CELL--A blank space--box--created by the intersection of a row and a
column, in which data may be entered. Any entry in a cell remains entirely
in that cell, regardless of how it appears on the screen. Cells are referred to
by Letter and Number, e.g., cell A1, cell C8 or Cell IV65,536, the last cell on
the lower right corner of the spreadsheet!



6. MERGE--Combining two or more cells into one cell. Used for headers, etc.

7. FORMULA--A mathematical calculation in a cell. For example, if the user
types < =SUM(+6-2) > in a cell, and clicks enter, the answer, <+4 >will
appear in the cell in place of the formula. Or the formula may read
<=SUM(+A2-A3) >, and Excel will subtract the number in cell A3 from the
number in A2, and the total will appear in place of the formula

8. WORKBOOK--Another word for one Excel file. When a new Excel file is
opened, it will usually be named "Book 1" until it is saved under another
name. WORKSHEET--Spreadsheets within one Excel workbook or file,
which are named Sheet 1, Sheet 2 and Sheet 3 by default. Worksheets can
be found at the bottom of the Excel Window, and can be named by double
clicking on the worksheet tab. Most workbooks open with 3 worksheets,
but the default can be changed or more worksheets can be added or
deleted at any time to a workbook

9. CHART--Usually means a spreadsheet with a title, row labels and column
headers that has been formatted so the viewer can easily read the data in
each cell. Charts are sometimes referred to as graphs, as well

10. GRAPH--Graphs are the visual representation of numerical data, most
commonly presented as bar, line or pie graphs

11. GRIDLINES--the lines that define a cell. The light lines that are visible on a
new Excel spreadsheet do not show when printed, unless the user adds
gridlines

12.RANGE--refers to one or more cells chosen (usually highlighted or
selected) for an operation. Cell 1:A2 refers, of course to the two cells only,
A1 and A2. A range of cells A1:B2 refers to cells A1, A2, B1 and B2, or 4
cells.

In this tutorial, the user will learn the following basic information that will allow
the user to perform basic tasks in Excel:

o About Workbooks and Worksheets in Excel
Understanding Cells
Formatting a spreadsheet for both Utility and Aesthetics
Working with Data in Excel (includes formulas--the MATH thing!)
Graphing in Excel
Sorting data in an Excel spreadsheet

o Using Excel for database functions (filtering)
This tutorial cannot begin to cover the entire scope of Excel, but it will give the
new user a good background to begin his/her exploration of this exciting tool.
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About Workbooks and Worksheets in Excel. Lesson 2.

An Excel file is referred to as a Workbook, and as we all know, that which is in a
Workbook are called Worksheets! Therefore, inside an Excel Workbook are
spreadsheets called Worksheets.

[Open a new copy of an Excel workbook.]

Note that the name at the top of the picture the workbook is named “Microsoft
Excel-Book 1” and the names of the three worksheets at the bottom are “Sheet 1,
Sheet 2, and Sheet 3.” If perchance the “sheets” at the bottom and the scrollbars
are not visible, click the “Restore Window” square in the upper right hand corner
of the screen.

When the file is saved, the “Book 1 or Book 2” file title will change to the file
name under which you saved the file.

Most blank workbooks have 3 worksheets that are available by default. Click on
each Sheet in your file, and see that you are opening identical blank work sheets
within that one file. Try adding a new additional blank Sheet by clicking Insert,
and then Worksheet, and you will see an additional Sheet added to the bottom. To
change the number of Sheets that appear on every new Workbook you open, click
Tools, Options, and then pick any number of Sheets from the Sheets in new
Workbook pull down menu. (2007: Click the Insert Worksheet Icon down at the
bottom by the Worksheets).

The user needs to name each Sheet to be used in a Workbook. To name a
Worksheet, double click on the Tab, and type in the Worksheet name. Try naming
your worksheets Sheets Sheet A, Sheet B, and Sheet C. You may close this Excel
file and do not save it, and continue with the tutorial.

[Open the file Excel Tutorial].

Your Excel Tutorial file will look like this (below) when you open it. Notice the
Worksheets the arrows point to at the bottom of the file. Each Worksheet
correlates with one of the lessons found in this tutorial.






Understanding Cells. Lesson 3

This tutorial is designed for the student to follow along and complete a variety of
hands-on skills using Excel. To practice these skills, the student will need to
download excel_tutorial.xls in the Unit Guide, save the file to a hard disk or floppy
disk, then re-open it for the tutorial. Do this now.

[In your Excel_Tutorial file, click the worksheet titled “Cells”]
To understand a spreadsheet, the user must understand the basic terminology of
rows, columns and cells. Open a new spreadsheet, and look at it carefully:
o Rows run horizontally across the page, and are denoted with numbers
o Columns run vertically down the page (like columns on the front porch)
and are denoted with capitol letters
o Cells are the “boxes” created by the intersection of rows and columns

Look for the cells that have been labeled for you: A1, B3, D5, F8 and H13. Click in
any open cell to see that it is easy to tell where the cursor is because the cell will
be outlined in black. Also note that the location of the cursor is stated in the
“Name Box” in the box in the upper left side.

[click on the worksheet titled “Type in a Cell” in the Excel Tutorial]

A key concept the user must understand in EXCEL is ANY DATATYPEDIN A
CELL REMAINS ENTIRELY INSIDE THAT CELL, REGARDLESS OF WHAT
APPEARS ON THE SCREEN. In your Type in a Cell spreadsheet, notice 20 or 30
letters in a Cell B2. Notice that the characters overrun Cell B2 and spill over into
Cells B3, B4, etc. But now, click in Cell C2, and type some numbers, and you see
that the extra letters in B2 seem to disappear. However, if you click back in B2,
notice that all the characters are still visible in the formula bar at the top (just
under the Icons) but are not visible in the cell.

It is important to remember that Excel assumes when the user enters a number in
a cell, the user intends that number is going to be used to make a calculation;
and if text is entered, that text will be a row or column header. Excel also
assumes that the +, -, *, /, @, $, (, ), and = keys are to be used in mathematical
calculations, and are not text.



Formatting Skills in Excel
(Using the Format Menu). Lesson 4.

The skills in formatting a spreadsheet are the basis and foundation for all the
subsequent skill such as graphing and calculations. The user needs to ensure
that these skills are mastered before going forward.

(2007: THE
COMMANDS THAT WERE UNDER THE FORMAT MENU ARE
UNDER HOME AND PAGE LAYOUT TABS. THER ARE SOME
LITTLE ‘ARROWS’ AT THE BOTTOM OF THE RIBBONS,
WHICH IF CLICKED ON, BRING UP THE OLD EXCEL MENUS.
UNDER HOME, LOOK TO THE RIGHT OF THE WORD
‘ALOGNMENT’ TO SEE THE ARROW THAT WILL LEAD TO
THE ‘OLD’ FORMAT MENU.

[click on the Format Skills worksheet in the Excel Tutorial]

Click and study the Format menu for a while. First, note that the pull down menu
contains three sub-menus the user will use every time something is done in
Excel: Cell, Rows and Columns. Basically, just about everything a user would
need to do in terms of formatting is under one of these three sub-menus. You
need not memorize all these operations, just know that to format text and
numbers, look around in the Format menu.

On the spreadsheet, practice each of the operations below by using the Format
menus:

o Merge Cells C7:D13 (note the term RANGE) together [Highlight the cells to
be merged, and then click Format, Cells, Alignment, Merge Cells, and OK]
Note that the colon between C7 and D13 indicates all cells in the RANGE
from C7 through D13, (2007: MERGE COMMAND IS UNDR THE HOME TAB
AND THE ALIGNMENT RIBBON.

o Slant the text in the merged cells C7:D13 to a 45° angle [Select the merged
cell, then click Format, Cells, Alignment, then in the Orientation box, drag
the line to the proper angle or enter the angle manually, and OK]. (2007:
CLICK THE ORIENTATION TAB OR THE ARROW TO THE RIGHT OF
ALIGNMENT UNDER THE HOME TAB.



o Widen Column B to a width of 14 and make Row 15 higher to a height of 30.
[Format, Column, Width, enter 14 and OK]. [Format, Row, Width, enter 30
and OK]. (2007: CLICK Format Cells under the Home tab)

o Wrap the text in cell E15 to fit more text in one cell [Click on cell E15, Click
Format, Cell, Alignment, then click the Wrap box, and OK. The row height
may need to be changed, as per the 2nd bullet above] (2007: CLICK Format
Cells under the Home tab)

o The numbers in G4:G7 have been formatted to reflect currency, decimal,
date and time. Use the Format, Cells Number, Category path to change the
formatting for each cell to the option suggested just to the right of each cell
[Click on the cell, Click Format, Cells, Number, choose the appropriate
Category, and make your change (2007: UNDER THE HOME TAB, USE THE
NUMBER RIBBON)

o The font style, size, margin alignment and background have been changed
in the text in H9:H11. Change each cell again as suggested by the cell to
the right of each. [Click the Cell, click Format, Cells, Font, and then choose
the font style, etc.] [Fill color is Format, Cells, Patterns, choose the color,
and OK.] [Right, Left and Centered text is Format, Cells, Alignment,
Horizontal, Choose the alignment, and OK] (2007: UNDER THE HOME TAB,
USE FONT AND ALIGNMENT RIBBONS)

There is virtually no way a casual user will remember all the key strokes
necessary to perform all the functions shown above.

(2007: USE THE HOME TAB MOSTLY)

So far, we have learned to format text by using the Format Pull Down Menu, but
there is also an icon (GUI) for almost every function that is listed above. If the
standard, drawing and formatting tool bars are open, (View, Toolbars, then either
Standard, Formatting or Drawing) the user can click on a cell, then click on the
appropriate icon. Try to find the icons for Bold, Italics, Underline, Merge Cells,
etc. (2007: USE THE HOME TAB TO FIND THESE NEW ICONS IN 2007)

Additionally, there are also ways to change used by experienced users to adjust
the width of columns and the height of rows.

1. Double click on the line below any row number, and the cell height will
change to fit the text or numbers entered; OR grab the line below a row,
click the mouse and hold it down, then drag the line down to manually
increase row height

2. Double click on the line to the right of any column letter, and the cell width
will increase to accommodate the text or numbers entered; OR, click on
the line to the right of any column letter, hold the mouse button down, and
drag the line to the right to increase a cell width



Try both these methods to increase and decrease row and column size.



CONVERTING A SPREADSHEET INTO A PRESENTATION-QUALITY
TABLE/CHART IN EXCEL. Lesson 5

It is important that charts made in Excel be easily read and understood by the
viewer. To make a spreadsheet easy to read,

1. make it as large as possible,
2. use fonts and colors that are appropriate to the size, and
3. make sure titles and row/column labels are clear.

Below are two spreadsheets that show 4 years of TAAS scores for Ima Tellin’ U
Middle school. The top spreadsheet contains RAW data just as it would be
entered into the spreadsheet, while the bottom one has been reformatted to be

easy to read.
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[Click on the Format Chart worksheet in the Excel Tutorial]

Make your practice worksheet look similar to the reformatted worksheet in the
example by using the formatting skills you should know from Word, such as font
size and style, bold, etc., and the skills already learned in this tutorial such as
adjusting cell width and height, and merging cells. Additionally, there are other
skills that were needed to make the chart above look aesthetically pleasing:

e Grid lines--the dark lines around each cell. [Click on cells that grid lines are
to be added to, then click the Borders Icon, and choose the grid line type]
(2007: USE THE BORDERS ICON IN THE FONT RIBBON UNDER THE HOME
TAB)

e To add a row, [place the cursor below where the new row will be, and click
Insert, then Row]; [adding columns works the same way, but we don’t have
to do that on this chart]. (2007: USE THE INSERT ICON IN THE CELLS
RIBBON UNDER THE HOME MENU)

(2007: FILL COLORS AND FONT COLORS ARE IN THE FONT RIBBON
UNDER THE HOME MENU
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o Working with Data in a Spreadsheet. Lesson 6

A primary function of Excel is to analyze and manipulate numbers and numerical
data. This section will deal with copying cells, relative vs. absolute values and
formulas.

[Open the Data worksheet in the Excel Tutorial]

When a numerical value is entered into a cell, that number becomes the “cell
value” of that cell. On your spreadsheet, click on cell B2, and note that the
numerical value 100 is in that cell. Next, click in cell B4, and enter “=B2” and then
hit the enter key. You will notice that 100 appears in cell B4, not =B2, because the
cell value of cell B2 has been referenced. In other words, you have keyed in a
simple formula: by using the = sign in front of the B2, you have told Excel to put
the numerical value of B2 in that cell.

Copying a numerical value is easy in Excel. Go back to the spreadsheet, and click
on the 100. Now copy the cell, and then highlight cells F2:H2 and Paste. You have
pasted that value into other cells.

Excel fills in a series of numbers (or other row/column label data) by clicking and
dragging. Say you want to increase a number by 5: The values 5 and 10 are typed
in Cell A6, and B6. Next, highlight both cells, let the mouse button up, move the
mouse to the bottom right corner of cell B6 (over the small black box in that
corner) until the cursor changes shape, click the mouse and drag to the right—
watch Excel fill in the trend, counting by fives.

The same process works for column (and row) headers. January and February
are typed in cells A8 and B8. Follow the same process as above and watch the
months fill in to the right. This also works for days of the week, and other things.

Excel also trends a random sequence of number. Note that in Cells A10:F12, a
chart has been made that shows the number of students at Whyarewehere HS
through 2003, and has blank cells for the projecting the number of students in
coming years. Excel will trend these numbers, based on the prior years’ history.
This may or may not be accurate, depending on whether the TREND stayed the
same. To trend the numbers out, highlight cells B12:F12, click on the box at the
bottom right corner of cell F12, and drag the mouse to cell 112. Presto! You have
made a projection for the future based on the past!
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USING FORMULAS IN A SPREAD SHEET. Lesson 7

[Open the Formulas worksheet in the Excel Tutorial]

It is necessary to learn to use formulas to unleash the real power of Excel.
Formulas are simple a matter of typing in information that everyone learned in
math class. In the simple spreadsheet calculation in the Formulas Worsheet, note
that the number 37 is in A1, the number 3 is in A2. Enter this formula:
=sum(A1*A2) in Cell A3. What this does is multiplies the cell value of A1 times the
cell value of A2. Press enter, and see if you get the correct answer--- 111.

All simple calculation formulas start with the Universal Formula in Excel: simply
the = sign, or = sum

Then open parenthesis (

then the first cell reference A2

followed by an operand (+, -,/ or *)

then additional cell reference(s) and operands, B2

then close parentheses )

Example: the formula to ADD 37 and 3 on the tutorial spreadsheet would be
=sum(A1+A2) or =(A1+A2) . On your spreadsheet in Cell A3, try some simple two-
cell addition, subtraction =(A1-A2), multiplication =(A1*A2) and division problems
=(A1/A2).

Examples of Formulas one might see on other spreadsheets for more complex
calculations:

=sum(a4+b4)/(2b2)

=SUM(B4+D4)?-(D5)*

Note: after a formula has been entered, it may later appear without the SUM. For
example =sum(A1+A2) may appear as =A1+A2. Also, for a simple calculation
such as =a1+b1 it is not necessary to use the parentheses, but get in the habit of
doing it anyway, because it is necessary in more complex formulas.

(2007: USE THE FORMULAS TAB TO FIND THE Sigma CHARACTER ICON AND
OTHER FORMULA TOOLS INCLUDING THE FUNCTION ICON MENTIONED
BELOW)

To add a longer column of numbers, such as those in Column C, it would be
cumbersome to have to type in the cell reference of each cell, so the AutoSum
feature is used to add columns or rows of numbers. The AutoSum key is the
Sigma character () (icon) on the toolbar. On your Tutorial, place the cursor in
the Cell 10, where the total will go, then click the Sigma (AutoSum) Icon on your
toolbar, then touch the Enter key, and the Cells C1:C9 will be automatically
summed.

There are hundreds of other possible formulas that one might use in Excel in
addition to the SUM formula. While most of these formulas would not be used by
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teachers, some knowledge of the range of possibilities may someday help
teachers, especially math and science teachers, or teachers who become
involved in any type of research or statistics. It is impossible (and useless) to
memorize the large numbers of formulas, but finding them is easy: first, place
your cursor in the cell in which you will perform the calculation, then either click

Insert, Function or click the Paste Function Icon (/ﬁ,). Next, you will see the
Paste Function dialogue box, which contains all the function categories on the
left and the function names on the right. To practice, click Cell C10, the use
either method to bring up the Paste Function dialogue box, choose the Statistical
category, and the AVERAGE function, and OK. A box will come up that basically
asks if we want to AVERAGE cells C1:C9, which is what we want to do, so click
OK and the AVERAGE will appear. (Note: if you wanted to average the numbers
in some of the cells, but not all, you would select the cells to average, then click
OK). Now, try the STANDARD DEVIATION calculation in C10 by following the
same steps: Insert, Function, Statistical, STDEV, OK, OK

Formulas can also be copied in Excel so that several columns (or rows) can be
added without having to type in a formula for each column (or row). However, this
is where the user has to understand the “relational” nature of Excel. Look at the
Cells E1:G4, in which three columns are to be totaled. In Cell E5, key in the
formula =sum(E1:E4), and click Enter to total the cell values in column E. Or,
use the Sigma function to total column E.

Now, to copy a formula to an adjacent cell, click once in Cell ES5, click the bottom
right corner of that cell and hold down the mouse button, and the drag the
formula to the right to Cells F5 & F6, then let up the mouse. Excel will transfer
the formula to the right, and add the numbers in columns F and G.

But why when the formula in Cell E5, =sum(E1:E4 ) was copied to the right, did
Excel add up column F in Cell F5 and column G in Cell G5? The copied formula
added the columns to the right because Excel is “relational” in nature. In other
words, when the formula in E5 was copied to the right, the formula automatically
changed to =sum(F1:F4) .

In this example, THE RELATIONAL NATURE OF EXCEL allowed the user to copy
a formula at the bottom of one column to the next column to get the correct
answer. Copying formulas to the right in columns or down in rows USUALLY
works fine.

However, BEWARE, because the RELATIONAL NATURE OF EXCEL can cause
one to copy an incorrect or unworkable formula. Look at the little grade book in
1:M7. The teacher has assigned points for two units, and added the total points
for three students; then, in Cell M2, the teacher has divided the total points
earned, L2, by the total points possible, L7, ( =sum(L2/L7) to get a "percentage"
of 0.84. So far, so good. But what will happen if we drag (COPY BY DRAGGING)
the formula in M2 down to M3 & M4—Ilook at the formula in M2 and try to guess.
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Click on M2, drag the formula down to M3 and M4. What happens & why? The
“copied” formula in M3 is, =L3/L8, which does not work because we needed to
divide the total by L7, not L8. Examine the copied formulas carefully to see what
was divided by what, and you will see why the relational nature of Excel resulted
in the wrong answer.

Now, to make any CELL "ABSLOLUTE"--that is, "fix it" so it is not RELATIONAL--
put a Dollar sign ($) in front of the column letter and row # (in this case, $L$7) that
you want to remain CONSTANT in a formula. So, in Cell M2, your formula needs
to be =sum(L2/$L$7). (Note, you can either recopy the entire new formula in the
cell M2, or add the $$ signs in the formula bar by clicking before the L and before
the 7.) Enter that formula, and try the copy process again

A cell reference can be made absolute (as opposed to relational) by putting a $
sign before the column letter and a $ sign before the row number in a formula. In
other words, if you want to have a CONSTANT in a formula, put a $ sign before
the column letter and a $ sign before the row number that you wish to remain
constant, and that will override the RELATIONAL NATURE OF EXCEL.
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Lesson 8: Creating Forms in Excel

It is relatively easy to create a simple form in Excel. Such forms can be printed
and filled in with pen or pencil, or can become digital forms to filled in with the

computer. More complex forms obviously take more time, but the skills are the
same as for a simple form.

Usually, the best way to make a form is to sketch a rough drawing on paper,
widen cells, raise row heights, merge cells and add cell borders (grid lines) to
complete the form. With a little practice, it is pretty easy to become a “form
expert.”

In the tutorial, all you need to do is follow these directions to learn to do a simple

form. The typing is done for you—all you need to do is the formatting

[Open the Forms worksheet in the Excel Tutorial] Follow the steps below to make

a form in Excel.

o Use File, Page Setup to change the orientation to Landscape
Merge & center Cells A1:11; Change font to 14; Increase Row Height to 18
Merge & center Cells A2:12; Change font to 14; Increase Row Height to 18
Widen columns C thru H to 14
Raise height of rows 4 thru 9 to 36

Oo0Oonoan

to add black lines

Your form should look like the form below:

Select (highlight) cells A1:19; Use the Borders Icon and choose All Borders
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Of course, as you look at the form, you will see a number of corrections and
improvements one could make to improve the aesthetics of the form, but if
you did this tutorial, you have the general idea. Of course, if you need to make
a more complex form, you will need to work at it a bit to learn how to do that,
but that is not the purpose here. The takeaway for this exercise is that it is
fairly easy to make a simple form in Excel of the type teachers often need to
make, simply by merging cells and using the formatting skills one learns with
Word and Excel.
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